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I ntroduction

Congratulations for acquiring PhoneCrypt and assuring the confidentiality of
your communication!

PhoneCrypt is the best and the most advanced voice encryption solution
available on the market nowadays, as it assurestota privacy and security to
mobile phones, using the most powerful encryption agorithms, protecting
the conversation against the most sophisticated interception attempts used by
spies, competitors, investigators, phone companies, military or governmental
organs, etc.

PhoneCrypt alows a secure communication between you and your business
partners, friends and relatives, assuring the confidentiality of your
conversations, working with powerful protection mechanism based in 4096
bits RSA and 256 bits AES miilitary grade encryption.

PhoneCrypt can beinstalled on any Windows based machine. The software
works using your internet connection, to its best performanceit is
recommended that you have a good connection speed.

Next, you will find some orientations to use PhoneCrypt and itsMenuin a
practical and efficient way.



1. Installation

1.1 Basic Requirements

To install your PhoneCrypt Desktop you need:

- Windows XP/Vista/Windows 7 or 8
- 1.0 GHz Processor

- 256 MB RAM memory

- 5.3 MB free space on disk

1.2 Installing PhoneCrypt Desktop

To install your PhoneCrypt Desktop you need to extract the setup file if
zipped, and run the setup. On this first screen, select the language of the
setup and click on OK.,

Select Setup Language [ |
Select the language to use during the
y installation:
[English - |
[ Ok ] | Cancel l J




On this screen you can see the PhoneCrypt Desktop version which will be
installed, click on Next

Welcome to the PhoneCrypt Client
Setup Wizard

PhoneCrypt This will install PhoneCrypt Client version PhoneCrypt

fofmain foe v 2.9,17.1959 on your computer.

Itis recommended that you dose all other applications before
continuing.

Click Mext to continue, or Cancel to exit Setup,

[ Next> | | cancel ]\II




On this screen, choose the path to install PhoneCrypt and select next:

Select Destination Location ‘
Where should PhoneCrypt Client be installed?

l Setup will install PhaneCrypt Client into the following folder.

To continue, dick Mext. If you would like to select a different folder, dick Browse.

C:'Program Files (x86)\PhoneCrypt _ Browse...

At least 6.9 MB of free disk space is required.

English

<Back || MNext> | | C@fﬂ




Now select the Start Menu folder entry for PhoneCrypt and click on Next.

Select Start Menu Folder P
Where should Setup place the program's shortcuts?

u Setup will create the program's shortouts in the following Start Menu folder.

To continue, dick Mext, If you would like to select a different folder, dick Browse,

PhoneCrypt Client Browse...

Endlish

<pack ][ Next> | [ cance ]I




On this screen choose the components to install and click on Next

Select Additional Tasks

Which additional tasks should be performed? j

Select the additional tasks you would like Setup to perform while installing PhoneCrypt
Client, then dick Mext.
Additional icons:
[] create a desktop icon
| Create a Quick Launch icon

English




Now click on Install to proceed with the installation:

Ready to Install
Setup is now ready to begin installing PhoneCrypt Client on your computer,

Click Install to continue with the installation, or dick Back if you want to review or
change any settings.

Destination location: -

C:\Program Files (x8&)\PhoneCrypt

Start Menu folder:
PhoneCrypt Client I

Additional tasks:
Additional icons:
Create a Quidk Launch icon

English

<Back || Instal I[”cm;]l




On this screen you need to either create a new account (if you don’t have
one) , or enter your current account details:

Please decide whether you want to create a new account now j

Do you want to careate account now?

() Iwant to create a new account now

@ I already have a PhoneCrypt account

Endlish

||
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If you chose to create a new account, you will need to fill out the form
below:

COMPATIBLE DEVICLE | DOVWHOSDE | PARTIERS | RAIFEREMCE | ABOUTUS | COMTACT

Registration Form Office Locafons

Securstar GmbH - Headguarters

Farsl My
i Schreeginckchen Ste. 15

Lasd Fame B-500EE Mlnchan - Sarmany
Phors) +£5-B9-TIOGS1T-D
Pratermed rechsa s (o be displayyed Foxt +43-B0-7106617-29
Web: DL v gooyrstnr o
i Eoviis gt o

Passwaord {7 or more characters)

eenfirm aassasrd

Eneail (Only ane Emoll per ooosunt ollowmed §
g z

[ Submit

After you fill everything out and submit it you will receive a confirmation
email for the account activation. Click the link in the email and shortly you
will receive your account details.

If you choose “ | already have a PhoneCrypt account”, you will have to enter
the details you already have and click on Next.

Y ou can aso choose “Skip” to enter the account details later.

Finish the installation.
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1.3 Removing PhoneCrypt Desktop

To remove PhoneCrypt Desktop go to the Start menu of Windows, Control
Panel- Uninstall a program, and on the PhoneCrypt client menu select
Uninstall.

Click on uninstall to proceed, and after the uninstallation is done click on
close.

2. Configuration

2.1 Configuring your language

To choose your language on the SoftPhone go to the File menu and select
between the avail able languages, as the screen below shows:

12



[% PhoneCrypt | = O S

:.-F”E | Account "l"IE':N. I:Ieh:l .Sgcuiﬁlar
Language » [ German
=L Setings... English -
o Exit Portuguese
ﬁ L 1 Romanian
e
e - Russian
Ukrainian
£ contacts |

= =]

"PhoneCrypt§Softphone

2.2 Configuring your Account and Network Server

To configure your username and password, go to File- Settings-
Account and type in your login details and click on Save.

To setup the server, go to File- Settings- Server and make sure the
server name hspes.net:8000 is entered and Save the settings.
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Server settings

Server list

Server Server Pricrity

hspes.net:3000 i

Security Raise priority | | Remove from list |

Add server:

)

2.3 Configuring the Audio
To configure the audio settings of your PhoneCrypt go to the File menu and

select Settings. Now click on the audio section, which will open the window
below:
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Audio settings

Output device: [Speakoers (High Definition Audic ]
Serwer

Cutput level; | ; U
Audio

Input device: [I"«"kcropl'mie {High Definition Au v]

| Sound

Input level: | f U
Chat Lize microphone boost
Advanced Level echo suppression: [Moderabe "]
Security

On this screen select the input and output devices that you will use with
PhoneCrypt Desktop, by clicking the combo box, and adjust the level of
your devices. Now click on the “save” button.

15



2.4 Configuring the Sound

You can choose the sounds to ring on each specific event of PhoneCrypt
Desktop, to customize your sounds click on File, go to Settings and select
the Sound area, which will open the window below:

Sound settings

Account Event File name
Do busy sound/busy.wav

ringing sound/ringing. wav

[ Audia dizltone sound/dialtone . wav

message sound/message.wav
Sound
Chat
Advanced
Security

| | Play |
|

Y ou can choose other .wav filesto play in these events, so fedl free to create
your own files.
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2.5 Configuring the Chat

To configure your chat options, go to File-Settings-Chat and customize the
settings to your liking, as shown below:

Chat settings
Account Save message history
D Open messaging window on incoming message

_ Sound notification on incoming message
Audio while messaging window is not active

[ Keep chat connection alive

Sound
[ Send message
Chat (@) on Enter (7} on Cirl+Enter
——
Advanced I

Security
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2.6. Configuring the Advanced Options and Security

In order to configure these options go to File-Settings-Advanced and chose
how the application will start, login, update etc. :

-
Settings | X |
Advanced settings
Accaunt [¥] Login automatically when application starts
i || Run automatically on system startup
[¥] Reconnect upon disconnection
Audi .
s |3 Allow single application instance only
Sound [¥] automatically chedk for updates
Double-dick on contact:
Chat
. I Call @ Chat
Advanced
: .|
Security
Save

Login automatically when application starts. With this option checked,
each time you start PhoneCrypt Desktop it will automatically log you to the
previously configured account.

Run automatically on system startup: Marking this option will make
Windows start PhoneCrypt Desktop every time your OSis|oaded.

Reconnect upon disconnection: This option will make PhoneCrypt
Desktop reconnect each time it disconnects due to network issues.
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Allow single application instance only: Un-checking this option enables
you to open various PhoneCrypt Desktop instances, enabling you to use
several accounts at atime.

Automatically check for updates:. Checking this option will make sure that
each time a new version is released the software will prompt you to
download the | atest one.

Double-click on contact: By double-clicking on a contact you can select
what action will be taken, either call the contact you clicked on or open up
the chat window.

Going to File-Settings-Security will allow you to set up a master password
for the application. By default no master password is set up, but you can
check the box “Use master password” and create a new password.
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3. Using PhoneCrypt Desktop

3.1 Logging into your account

To login your account, you just need to click on the Account Menu and press
the online button

[& PhoneCrypt ki
Fie | Account | View Help w@
I % e | 2“
=& = Offine

L Find user....

8 remove user .
ﬂ-:'g’ Change password... T
ﬁ 'E’ Change name. ..

s Message history. ..

PhoneCryptEsof
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This will bring up your contacts list, which will look like the following
screen:

B PhoneCrypt =

File Account View Help w&r
@v Online 2 k

testd | 9

2 contacts ID Numpad ]

100020 Test 5
100021 Test &
100024 Testd
100025 Test 10
100026 testll
100027 testl2
100134 testl

BEERERRRERR

B2 b b b B b B

PhoneCryptfSoftphone
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On this screen you can see the status of your contacts, which will show
online when the padlock and theicon of the user are active.

Y ou can aso see the UID and the name of the user (the UID can be used to
make a call through the Numpad)

To logout your account, click on the Accounts menu and select the Offline
button.

3.2 Adding and removing users

On the accounts menu you will also have the option to add and remove a
user from your list. To add auser, click on Accounts Menu — Find User

To search for a user to add, type his name and press the Search Button.
Now select the target user from the search and click the Add button. This
will add the user to your list.

Search request

Search result
E Mame

100134 testl
100025 Test 10
100026 test1l
100027 testl2
100017 Test2
100013 Test3
100019 Test 4
100020 Test 5
100021 Tests
100023 Test 8
100024 Testa
100022 test d

Add ] [ Cancel

Toremove auser, select it from your contacts list, and on the account menu
select and click on the remove user option.
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3.3 Making acall

To be able to make a call you have to be Online on your PhoneCrypt
Desktop and your contact online as well.

On the main screen of PhoneCrypt Desktop, choose in your list the name of
the person with whom you wish to talk to(the status of the person needs to
be “online”, which means the padlock will be yellow) and click on the green
telephone icon at the bottom on the screen. Another option is to start the call
double clicking your online contact.

| PhoneCrypt R o<
File Account View Help SecuriStar
B2~ onlne .2. Eﬁ
H test d |
W L 10022
k|
2 contacts | [| Mumpad
© 100017 Test2 W=
100018 Test3 |
£ 100018 Test4 &8

100020 Test s
© 100021 Test6
100023 Test8
100024 Testd
100025 Test 10
T 100026 testil
100027 test12
100134 testl
100253 ant
© 100254 jok
100284 my_test & .

- a
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Once the cal is started, PhoneCrypt will create a safe point-to-point
connection, directly with the other user.

During the conversation, you will see on the screen a security code. It shows
you the unique conversation ID; this ID must be the same for both sides that
are communicating, as this assures there is no “Man-In-the-Middle” attack

happening.

Please, tell the security code number to the other person and be sure this
person has the same number appearing on higher PhoneCrypt Desktop

display.

If the security code number of the other person is different from the one that
appears on your display, the communication might be not secure and a
“Man-In-the-Middle’ attack might be happening. Please, hang up and take
the appropriate measures against it.

% PhoneCrypt =]

File Account View Help mﬁﬂ

B2~ onlne 2,:; E.ﬂ
” :

g .
| & Contacts | ] Numpad | Y can — Tofinish acall, just click on Hang-up
Cu (Red Button).
Talking with:
Test 4
CONVERSATION SECURED

Security code:
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3.4 Sending files

In order to send encrypted files to your conversation partner, open up a

message windows and click on the “Send File” icon from the bottom left
corner.

4| Daiana )

=nn

Select your file from the desired location and click on “Send”.
Notethat you can also drag and drop filesinto the message window.

25



Muszaging windzn I 2

. =
& teyideiens Sgichal
Daiana [16:24:13 24-10-2014}
B Send Tulips jpg” (506 KB}
- il
Garding e,
A = Serd

The other party will see the incoming file transfer that can be accepted by
clicking on the green check button.

Doiana (162413 24-10-2074)
B nomeng fils Tulips,jpy” (808 KB)

Fit transfer cmplated

I T
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Once the transfer has completed you have a choice between opening the file
or the folder location in which the file has been saved.

Meszaging window |_ EI_ = |
: -;- Daiana _|
Daiana {16:24:13 24-10-2014)
& File "Tulips_jpg" (606 KB) download completed
Open file Open folder
Download completed. @

3.5TheView Menu

On PhoneCrypt Desktop you have the View menu to adjust it according to
your needs. Clicking the View menu will bring up some options.

Here you will have the options to sort the user by id, name or status.
Also you can choose the option to hide or show the offline users of your list
and choose to fit the window size to the default size.
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f FronsCrypt = |0
Fill  Aooodit | v | Heip sn’@
* || Sortusersby

. -
Bl Ofm Swrusrrbysang o

Sort usershby stall e

iy
o o S o LR
F
2 =L it Bormn sl
il:,mrlm

3.6 Changing Passwords

On PhoneCrypt Desktop you can change your account password at any time.
To do that, access the Account menu and select Change Password to bring
up the following window:

Change password L2 |

Password data

Old password:
Mew passward;

Confirm password:

ok | | conesl
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On this screen input your old password, the new password you want to use
and confirm the new password on the below field, that done click on OK to
confirm the change.

3.7 About PhoneCrypt Desktop

Clicking on the menu Help and on the About option will bring up the
information about the version of your software.

Sonc

Copyright © 2014 SecurStar GmbH. All rights reserved,
W, securstar, com

Y ou can aso check for updates manually in the Help section.
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